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Abstract — The rapid development of technology now increasingly requires easy and fast communication media. This was 

accompanied by the development of the internet, especially in Indonesia. It has been proven that almost all circles in Indonesia 

use the internet, both from mobile phones, computer devices, and other similar electronic media. The development of internet use 

in the world, especially in Indonesia, supports increased sales that occur in cyberspace. Almost everyone has used e-commerce 

applications, such as Tokopedia, Blibli, Amazon, and others. Of course the increase is good for all parties involved. However, of 

course there are disadvantages behind e-commerce applications that are rife on the market today. If the buyer wants to buy an 

item, he must talk to the seller to ask for the details of the item, what is being sold, and of course ordering the goods. Therefore, 

the author wants to make progress to facilitate buyers and sellers in interacting. This can be realized by creating a website-based 

chatbot. Chatbot is an algorithm that can answer questions asked by buyers. With the presence of chatbots on e-commerce 

websites, it is expected to facilitate sellers in responding to consumer needs. For buyers too, it will be very easy if you are in a 

hurry to find goods because the question will be immediately responded to by the chatbot. In this Final Project, the author 

developed a chatbot feature for online buying and selling websites, aka e-commerce. 
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I. PENDAHULUAN 

A. Latar Belakang 

Membeli barang secara online sekarang ini sudah menjadi hal yang umum. Berbeda dengan era sebelum internet 
berkembang pesat, yang mengharuskan pembeli untuk datang ke toko untuk membeli barang. Dengan adanya teknologi saat 

ini, pembeli tidak lagi harus datang ke toko untuk mencari barang. Pembeli hanya perlu mencari barang di situs pembelian 

online kemudian bertanya kepada penjual mengenai informasi produk. Kendala pada saat ini adalah dengan banyaknya 

pembeli online, otomatis penjual harus menanggapi pertanyaan dari pembeli. Tidak jarang pembeli menanyakan hal yang 

sama seputar informasi produk, ketersediaan produk, dan harga produk. Maka dari itu, penulis ingin mengembangkan 

sebuah layanan yang dapat menjembatani pembeli dengan penjual. Layanan yang dibutuhkan adalah sebuah program chat 

yang dapat membalas chat dari pembeli sesuai keperluannya. Layanan tersebut dapat diperoleh dengan adanya chatbot. 

Chatbot adalah sebuah layanan yang didukung oleh aturan dan terkadang merupakan kecerdasan buatan, dimana pembeli 

dapat berinteraksi melalui chat. Saat ini, chatbot sudah banyak digunakan antara lain sebagai command control, customer 

care, scripting engine, messaging application, virtual assistance, dan domain expert. Penggunaan chatbot secara spesifik 

dapat berupa weather bot, grocery bot, life advice bot, maupun bot sebagai teman.  

Berdasarkan masalah diatas, penulis ingin membuat program chatbot di dalam sebuah website e-commerce yang 
bertujuan untuk membantu transaksi jual beli secara online agar lebih efisien. Tidak hanya difungsikan sebagai mesin untuk 

menjawab pertanyaan, penulis ingin membuat chatbot yang ringan dan tidak terlalu kaku dalam berkomunikasi. 

B. Rumusan Masalah 

Berdasarkan latar belakang yang telah dijelaskan di atas, maka dapat disimpulkan rumusan masalah yaitu : Bagaimana 

chatbot membantu pengguna website? 

C. Tujuan Penelitian 

Tujuan dalam penelitian ini adalah : memberikan informasi seputar produk, memesan produk melalui chatbot yang telah 

dibuat, dan dapat melihat total pembelian. 
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II. TINJAUAN PUSTAKA 

A. Wix 

Website wix digunakan sebagai template untuk pembuatan website. Template dari wix memudahkan pembuatan website 

dengan desain yang menarik. Wix adalah platform pengembangan web berbasis cloud yang memungkinkan penggunanya 
membuat situs web HTML5 dengan cara drag and drop [1]. Editor Wix memiliki banyak template yang langsung dapat 

digunakan. Editor ini dapat digunakan untuk membuat situs web pribadi, portfolio perusahaan, situs jual beli online, dan 

bisnis.  

Pengguna dapat menambahkan berbagai fitur seperti tautan media sosial, online shop, email, dan community forum ke 

situs website menggunakan aplikasi yang ada di Wix. 

 

B. Chatbot 

Chatbot adalah sebuah sebuah program yang dirancang untuk bisa berkomunikasi baik teks maupun audio. Pada awal 
penemuannya, chatbot diuji melalui turing test. Artinya, identitas nya sebagai mesin dirahasiakan sehingga bisa mengelabui 

orang yang bercakap dengannya. [2] 

Jika pengguna tidak dapat mengidentifikasi chatbot sebagai suatu robot atau komputer, maka chatbot tersebut dapat 

disebut sebagai kecerdasan buatan. Untuk saat ini, chatbot banyak digunakan untuk tujuan praktis, seperti bantuan online, 

layanan personal, atau akuisisi informasi. 

Yang membedakan chatbot dengan sistem pattern-matching adalah kesederhanaan algoritma yang digunakan. Alan 

Turing dalam artikel terkenalnya “Computing Machinery and Intelligence” mengemukakan tentang tes Turing sebagai suatu 

kriteria kecerdasan. Kriteria ini bergantung pada kemampuan program komputer untuk meniru manusia dalam suatu 

percakapan tertulis secara real-time dengan manusia sebagai penilai, apakah program komputer tersebut cukup baik 

sehingga manusia tidak dapat membedakan sedang berhadapan dengan program komputer atau manusia nyata. 

 

C. AIML 

AIML merupakan singkatan dari Artificial Intelligence Markup Language. Berbasis dari XML (Extensible Markup 

Language), AIML dimaksudkan untuk membuat aplikasi cerdas buatan yang sederhana, mudah dimengerti, dan mudah 

untuk dilakukan pemeliharaan. 

AIML disusun oleh tag-tag atau atribut. Beberapa tag yang umum digunakan untuk sebuah program AIML yaitu sebagai 

berikut : 

1. <aiml> 

Tag ini digunakan untuk mendefinisikan awal dan akhir file AIML. 

2. <category> 
Tag ini digunakan untuk mendefinisikan pengetahuan yang ditanamkan ke AI (Artificial Intelligence) dalam bentuk 

kategori. 

3. <pattern> 

Tag ini digunakan untuk mendefinisikan karakter, kata, ataupun kalimat yang dimasukkan oleh pengguna. 

4. <template> 

Tag ini digunakan untuk memberikan balasan dari AI kepada pengguna. 

Selain keempat tag utama, adapula tag pendukung dalam program AIML yaitu sebagai berikut : 

1. <star> 

Tag ini dgunakan untuk mencocokkan semua karakter pada tag <pattern> yang dibuat dalam bentuk karakter *, ^, 

#, atau _. 

2. <srai> 

Tag ini digunakan untuk memanggil tag lain. 
3. <random> 

Tag ini digunakan untuk membuat proses pengacakan pesan yang akan didapat pengguna. Dalam tag ini harus 

terdapat list. 

4. <li> 

Tag ini digunakan untuk membuat list dalam program AIML. 

5. <set> 

Tag ini digunakan untuk membuat variabel dalam program AIML. 

6. <get> 

Tag ini digunakan untuk memanggil variabel yang telah dibuat oleh tag <set>. 
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7. <that> 

Tag ini berguna untuk memberikan jawaban kepada pengguna dengan menggunakan jawaban dari pertanyaan 

sebelumnya. 

8. <topic> 

Tag ini berguna untuk membuat AI membahas suatu topik tertentu. 

9. <think> 

Tag ini digunakan untuk membuat AI menyimpan variabel, namun variabel tersebut dapat tidak diberitahukan 

kepada pengguna. 

10. <condition> 

Tag ini berfungsi untuk membuat fungsi percabangan dari jawaban yang diberikan AI kepada pengguna. [3] 

 

D. Pandorabots dan AIML versi 2.0 

Pandorabots digunakan oleh penulis untuk membuat chatbot berbasis AIML. Penggunaan Pandorabots dikarenakan 

Pandorabots menggunakan AIML versi 2.0 yang mendukung fitur-fitur baru yang tidak terdapat pada AIML versi 1.0. Fitur 

yang terdapat di dalam AIML versi 2.0. diantaranya adalah :  

- Zero+ Wildcards : wildcard baru yang mencocokan 0 kata atau lebih. 

- Highest priority matching : memilih kata-kata tertentu untuk mendapat prioritas pencocokan teratas. 

- Migrating from attributes to tags : kontrol atribut yang lebih dinamis. 

- AIML sets : mencocokkan input dengan set kata dan frasa. 

- AIML maps : memetakan elemen set ke anggota set lainnya. 
- Loops : iterasi. 

- Local variable : variabel dengan ruang lingkup terbatas pada satu kategori.  

- Sraix : mengakses layanan web external dan Pandorabots lainnya. 

- Denormalization : kebalikan dari normalisasi. 

- Pandorabots extension : 

o Date : formatted date and time. 

o Request : access previous input request history. 

o Unbound predicates : check if a predicate has been set or not. 

o Learn : learn new AIML categories. 

o Learnf : learn new AIML categories and save in a file. 

o Explode : split words and phrases into individual characters. 
- OOB (Out of Bond) Tags : ekstensi AIML untuk kontrol perangkat seluler. 

Adapula beberapa fitur yang tidak terdapat pada AIML 2.0 yang dulunya terdapat pada AIML 1.0, yaitu : 

- Gossip : karena tidak pernah didefinisikan dengan baik. 

- Javascript [4] 

Karena tidak mendukung untuk javascript, maka penulis memutuskan untuk menggunakan API yang disediakan oleh 

Pandorabots untuk melakukan komunikasi dengan website eksternal. 

 

E. Pandorabots API 

Untuk dapat berinteraksi dengan platform website lain, contohnya Wix yang penulis gunakan untuk membuat website 
dibutuhkan sebuah perantara yaitu API dari Pandorabots sendiri. Aplikasi yang dapat menggunakan langsung pandorabots 

antara lain : 

1. Amazon .BOT Domain 

2. Apple Business Chat 

3. Facebook Messenger 

4. Google RCS Business Messaging 

5. Line 

6. Telegram 

7. Twilio 

8. Twitter DM 

9. Viber 
10. WeChat 

11. WhatsApp 

12. KikMessenger 
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13. Skype 

14. Slack 

Jika platform yang digunakan tidak terdapat pada list di atas, maka dapat menggunakan Pandorabots Channel untuk 

menambahkan chatbot Pandora. Pandorabots Channel terdiri dari Pandorabots API, Pandorabots Chat widget, dan 

Pandorabots Landing Page. 

 

III. RANCANGAN SISTEM 

A. Proses Pembuatan Website 

1. Masuk ke wix.com. 
2. Klik sign in di pojok kanan atas untuk masuk ke halaman utama. Kemudian login menggunakan akun Google 

ataupun Facebook jika tidak ingin membuat akun secara manual dengan cara klik Continue with Facebook atau 

Google. 

3. Jika sudah login, maka terdapat 2 pilihan. Penulis memilih membuat website dengan wix editor  dengan mengklik 

button “Choose a Template”. 

4. Kemudian pilih template yang sesuai dengan keperluan. 

5. Tempatkan gambar dan desain sesuai dengan keperluan. Beragam gambar  dapat digunakan untuk mempercantik 

website. 

6. Buat tombol-tombol untuk memudahkan akses ke halaman lain dengan cara klik Add > Button > pilih design. 

7. Wallpaper juga dapat diganti dengan gambar ataupun warna yang diinginkan dengan cara mengetuk background, 

lalu pilih Change Strip Background. 

8. Direkomendasikan juga untuk memodifikasi halaman lain agar sesuai dengan kebutuhan dengan cara mengklik 
panel sebelah kiri 

9. Buat halaman dengan cara klik tanda plus di navigation pane product. Klik add page 

10. Buat halaman yang diperlukan. Biasanya meliputi Home, Product, dan subproduct. Pada website Streetline, contact 

dan about us ada di halaman Home 

11. Tambahkan juga daftar keranjang (Shopping Cart) untuk melihat daftar belanjaan dengan cara Add > Store > 

Shopping Cart 

12. Contoh website yang telah dibuat 

 
 

B. Proses Pembuatan Chatbot 

1. Masuk ke website www.pandorabots.com 

2. Login ke dalam situs. Apabila belum mempunyai akun, dapat masuk menggunakan akun Google. 

3. Klik tombol + di “My Bots” untuk membuat sebuah chatbot baru. Isi nama, bahasa, dan konten sesuai keperluan. 

4. Setelah selesai, kemudian klik Edit > Code editor untuk mengedit kode program. 

5. Di dalam Code editor, terdapat beberapa folder yaitu AIML, Maps, Sets, Substitutions, dan System. Pada 

umumnya, pembuatan kode program dimasukkan ke dalam folder AIML. 

6. Klik File > New > AIML untuk membuat file AIML baru. 
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7. Memprogram chatbot di dalam folder AIML sesuai dengan yang kita butuhkan. 

8. Contoh chatbot yang telah diprogram 

 

C. Implementasi Chatbot ke Website 

1. Pada website pandorabots, klik deploy yang ada di panel sebelah kiri. Tampilan setelah mengklik deploy. 

2. Kemudian, klik add di internal bot directory. Kemudian isi data yang diperlukan seperti nama dan deskripsi. 

Setelah itu, klik Add. 

3. Setelah itu, klik Add di Pandorabots Chat widget. 

4. Pilih code, kemudian copy skrip. 

5. Kembali ke wix.com, kemudian klik Add > More > Embeds > Embed a site 

6. Setelah itu, terdapat sebuah kotak abu-abu. Klik Settings > Code. Dan paste code yang tadi sudah dicopy. 
7. Berikut contoh implementasi chatbot ke dalam website. 

 

D. Penggunaan Website dan Chatbot 

1. Pengunjung memasukkan alamat website. 

2. Pengunjung melakukan chat terhadap chatbot yang tersedia di dalam website. 

3. Pengunjung dapat menanyakan seputar informasi produk, memesan menu, dan menanyakan total harga. 

4. Semua pertanyaan pengunjung akan dijawab oleh chatbot. Jika ada menu yang tidak dapat dijawab oleh chatbot 

maka chatbot akan memberi jawaban seperti “Maaf kami tidak mengerti yang Anda maksud, silahkan coba menu 

lainnya.” 

5. Pengunjung dapat melakukan order dengan mengklik “Pesan”. 

6. Jika ingin kembali mengobrol, dapat kembali melakukan chat terhadap chatbot. 
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7. Pengunjung dapat mengecek total belanjaan dengan mengetik total harga pada chatbot. 

8. Jika telah selesai memesan menu, pengunjung dapat mengetuk “bayar” 

9. Pengunjung dipersilahkan untuk mengisi data pribadi, metode pengiriman, dan metode pembayaran. 

 

E. Flowchart 

Berikut adalah visualisasi urutan kerja website yang menggambarkan urutan proses secara detail 

START
konsumen melihat 

website
Mengobrol?

Konsumen 
mengobrol via 

chatbot

YA

Konsumen melihat 
produk

TIDAK
Konsumen 

memesan produk
Lanjut 

berbelanja?

YA

Konsumen mengisi 
data yang 
diperlukan

TIDAK

Konsumen memilih 
metode 

pengambilan barang

Mengambilo 
barang di toko?

Konsumen 
melakukan 

pembayaran
YACash?

Admin menerima 
pembayaran

YA

Cash?

TIDAK

Admin mengirim 
barang dan 
menerima 

pembayaran

YA

Konsumen 
melakukan 

pembayaran online

TIDAK

Konsumen 
melakukan 

pembayaran online
TIDAK

Konsumen 
mengambil produk

Admin 
mengonfirmasi 

pembayaran

Admin 
mengonfirmasi 

pembayaran

Admin mengirim 
barang

Admin membuat 
bukti pembayaran

END

 

F. Usecase Sistem Chatbot 

1)  Usecase sistem chatbot 

memesan produk

melihat info produk

mengakses chatbot

melihat total pembelian

Customer
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2)  Activity Diagram Chatbot 

Activity Diagram Chatbot Streetline 

Activity Diagram Chatbot Streetline

Customer Website Chatbot

Ph
as

e

mengakses website

menggunakan 
chatbot

menanyakan detail 
produk

menanyakan menu

mencari informasi 
produk

menampilkan 
informasi produk

menerima info 
produk

mau memesan produk?

memesan produk

YA

greetings

menanyakan 
keinginan customer 

sesuai topik

melakukan 
pemesanan

sudah selesai?

checkout

YA

TIDAK

mengucapkan 
perpisahan

TIDAK

menerima notifikasi

menanyakan total 
harga

memesan produk

 
 

G. User Interface Website 

Sistem website digunakan oleh pengguna untuk melihat produk, membeli produk, dan membayar produk. 
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IV. IMPLEMENTASI 

A. Tampilan bagan coffee 

 
Gambar ini merupakan tampilan pada pengaturan isi dari chatbot yang hanya dapat dikelola oleh admin. User hanya bisa 

menggunakan chatbot saja tanpa bisa mengubah kode program nya. 

V. PENGUJIAN 

A. Pengujian pattern <star> 

Tabel ini merupakan pengujian bagan pattern <star>, tabel pengujian berisi pengujian dengan memasukkan kata atau 

kalimat yang dapat dibaca oleh chatbot kemudian mengeluarkan kembali kata atau kalimat tersebut. 

No Test Case Hasil Harapan Hasil Keluaran Hasil Uji 

1 Memasukkan variabel 

dengan benar 

Mengeluarkan hasil 

yang telah di input. 

Variabel : Nama 

saya Boris 

“Salam kenal, 

Boris. Silahkan 

memesan di toko 
kami. Ada yang 

bisa kami 

bantu? :D” 

Sesuai  

2 Memasukkan data salah Menghasilkan error 

atau tidak match. 

“Maaf kami tidak 

mengerti yang 

Anda maksud” 

Sesuai  

B. Pengujian pattern <that> 

Tabel ini merupakan pengujian bagan pattern <that>, tabel pengujian berisi pengujian dengan memasukkan kata input 

pilihan. Chatbot akan memberikan pertanyaan dan user akan menjawab sesuai dengan konteks. 

No Test Case Hasil Harapan Hasil Keluaran Hasil Uji 

1 Memasukkan input yang 

sesuai 

Mengeluarkan 

jawaban sesuai 

pilihan 

“Ada yang bisa 

kami bantu?” 

Variabel : Ada / 

Ya 

“Mau pesan apa, 
<nama>?” 

Sesuai 

2 Mengisi data yang tidak 

sesuai 

Mengeluarkan 

error atau tidak 

match 

Srai input too long Sesuai  
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C. Pengujian pattern <think>/<set> 

Tabel ini merupakan pengujian bagan pattern <think>, tabel pengujian berisi pengujian dengan memasukkan kata atau 

kalimat untuk disimpan 

No Test Case Hasil Harapan Hasil Keluaran Hasil Uji 

1 Memasukkan satu variabel Menyimpan 
kalimat yang 

diinput oleh user. 

Muncul kalimat 
“Saya akan 

mengingat 

<input> anda” 

Sesuai 

2 Memasukkan data yang 

tidak sesuai 

Mengeluarkan 

error atau tidak 

match 

“Maaf kami tidak 

mengerti yang 

Anda maksud” 

Sesuai  

D. Pengujian pattern <regular expression>/<srai> 

Tabel ini merupakan pengujian bagan pattern <regular expression>, tabel pengujian berisi pengujian dengan 

memasukkan kata yang salah namun masih dalam konteks. 

No Test Case Hasil Harapan Hasil Keluaran Hasil Uji 

1 Memasukkan kata yang 

tidak tepat 

Dapat 

mengoreksi kata 

yang salah 

Mengoreksi 

langsung 

membenarkan kata 

yang salah 

Sesuai  

2 Memasukkan kata diluar 

konteks 

Mengeluarkan 

error atau tidak 
match 

Muncul “Silahkan 

pilih menu” 

Sesuai 

E. Pengujian pattern <topic> 

Tabel ini merupakan pengujian bagan pattern <topic>, tabel pengujian berisi pengujian dengan memasukkan kata yang 

membahas topik dan chatbot akan melanjutkan pembahasan mengenai topik tersebut. 

No Test Case Hasil Harapan Hasil Keluaran Hasil Uji 

1 Memasukkan topik yang 

ingin dibahas dalam 

chatbot 

Membahas topik 

yang dibicarakan 

Membahas topik 

yang dibicarakan 

Sesuai  

2 Memasukkan data yang 

salah 

Mengeluarkan 

error atau tidak 

match 

Muncul “Kami 

tidak mengerti 

yang Anda 

maksud” 

Sesuai  

F. Pengujian pattern <random> 

Tabel ini merupakan pengujian bagan pattern <random>, tabel pengujian berisi pengujian dengan memasukkan kata 

atau kalimat dan chatbot akan membalas secara acak. 

No Test Case Hasil Harapan Hasil Keluaran Hasil Uji 

1 Memasukkan suatu kalimat Mengeluarkan 
jawaban secara 

acak 

Muncul jawaban 
yang acak 

Sesuai  

2 Memasukkan data yang 

salah 

Mengeluarkan 

error atau tidak 

match 

Muncul “Kami 

tidak mengerti 

yang Anda 

maksud” 

Sesuai  

 

VI. SIMPULAN DAN SARAN 

A. Simpulan 
Penyajian informasi yang cepat, tepat, dan akurat sangat berperan penting bagi perkembangan suatu perusahaan. Dengan adanya 

aplikasi chatbot yang membantu berperan sebagai pemberi informasi, diharapkan dapat membantu pengguna untuk mendapatkan 
informasi secara tepat dan cepat. 
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1. Berdasarkan proses pembuatan aplikasi chatbot dalam website e-commerce ini dapat diambil beberapa kesimpulan, yaitu : 

Aplikasi chatbot untuk website e-commerce dilengkapi dengan beberapa fitur yang mempermudah pelanggan untuk mencari 
tahu deskripsi produk, memesan produk, dan membayar produk sehingga akan memudahkan pengguna. 

2. Aplikasi chatbot untuk website e-commerce dilengkapi dengan fitur yang memudahkan penjual untuk tidak menanggapi 
pertanyaan yang sering ditanyakan oleh pelanggan sehingga akan memudahkan penjual. 

B. Saran 
Demi kemajuan ke depannya untuk aplikasi chatbot agar lebih baik lagi ingin disampaikan saran agar dapat dipertimbangkan dan 

pengembangan program di kemudian hari. Aplikasi chatbot masih menggunakan fitur yang sederhana seperti mencari semua data di 
dalam website e-commerce, disarankan ke depannya agar jika ada info atau data terbaru untuk selalu diperbaharui dan tidak selalu 
mengandalkan data dari website saja. 
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